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Introduction
A Geography undergraduate student recently shared with me his observation that
Esri’s ArcMap application was looking incredibly old and out of date. He was a
student in an introductory Cartography course. His words brought back memories of
my own experience in a Cartography undergraduate course 10 years ago. At that
time, ArcMap version 9 was relatively new, but my class performed GIS tasks
(shapefile edits and exports) in ArcView version 3. I remember thinking about how
dated ArcView looked to me then and wondering why I was spending time learning
an outdated piece of software. Well, students are beginning to have similar
thoughts about ArcGIS 10. And much like my experience learning ArcView while
ArcGIS was widely used in the professional world, academia’s adoption of Esri’s
latest desktop GIS solution, ArcGIS Pro, has been slow.

Esri describes ArcGIS Pro as the centerpiece of the ArcGIS platform (Esri, 2016a),
while taking care not to declare it a replacement for ArcMap and its associated
products (Esri, 2016b). Esri released ArcGIS Pro version 1.0 22 months ago in
January 2015 (Elkins, 2015). The latest version, ArcGIS Pro 1.3.1, arrived in July
2016 (Garrity, 2016). Both ArcGIS Pro and ArcGIS for Desktop (which includes
ArcMap 10 and associated products) are currently offered in parallel by Esri. Pro
boasts an updated look and feel to its user interface that could be described as
modern. On the other hand, long-time devotees of ArcMap might describe it as
radically different. Beyond the user interface, Pro has yet to achieve the full
functionality of ArcMap but gets a little closer with each updated release. As Pro
continues to creep up on ArcMap in terms of functionality, I have been increasingly
feeling the need to begin learning the new product. As an administrator of my
campus’ Esri site license, I also want to be knowledgeable and conversant about its
strengths and weaknesses.

Over the 2016 summer period, I began working to familiarize myself with ArcGIS
Pro, and since then, I have used it for a few small GIS projects for my library. I
shared my thoughts on the process of learning ArcGIS Pro at the 2016 WAML annual
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meeting in September at Stanford. I was not too surprised to learn that very few of
my WAML colleagues had begun working with Pro. The following article is a
continuation of my presentation at the WAML meeting, and I will elaborate on some
of the impressions I shared there. The objective of this article is to introduce the IB
readership to ArcGIS Pro, provide an overview of the product’s strengths and
weaknesses, and discuss the implications of this new application on teaching and
learning GIS. Hopefully this introduction will ease any inhibitions Map and GIS
Librarians have about Pro and encourage IB readers to take it for a spin.

The User Interface
Open up ArcGIS Pro and the first thing you are likely to notice is an interface that
looks oddly familiar. Users of Microsoft Office tools will recognize that Pro  deploys a
ribbon-style toolbar across the top (Figure 1). The ribbon prominently displays the
most frequently used tools in a context-based organizational scheme. Much like
Microsoft Word groups complimentary tools on tabs then subgroupings (e.g.
subgroups of Tables, Illustrations, and Text are found on Word’s Insert tab), the
ArcGIS Pro ribbon features Map, Insert, Analysis, View, Edit, and Share tabs.

Figure 1. The ArcGIS Pro user interface. Note the Microsoft-style ribbon across the
top.

Compared to ArcMap 10.4, tools are much larger and easier to find, although they
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take up noticeably more screen space (it is collapsible, however). A big
improvement here is the ability to locate and access the Geoprocessing Tools,
which are nicely visualized on the Analysis tab (Figure 2). Users of ArcGIS Online will
probably notice some similarities in Pro, and the new application makes publishing
to an online account more seamless by way of the Share tab.

Figure 2. Top: The comparatively small toolbar items in ArcMap 10. Bottom: The
easy to find geoprocessing tools on the Analysis tab in ArcGIS Pro.

Esri has also taken steps to improve working in Layouts in ArcGIS Pro. In ArcMap,
simply accessing the Layout view can be a stumbling block to new GIS users. When
teaching or providing a GIS consultation to a student or new GIS user in ArcMap, I
frequently find that I have to make special note of how to access the Layout view. I
emphasize this point because the simplest way to switch from Data to Layout view
in ArcMap is by clicking a miniscule, and easily forgotten button on the bottom left
of the canvas. In Pro, the user simply clicks the Insert tab on the ribbon to find the
New Layout button, then the Layout will be available on a new tab above the main
canvas (Figure 3).  By design, users of ArcGIS Pro will find themselves on the Insert
tab frequently to create a new map, quickly reinforcing the practice of adding new
views to the project (more on workflow below). ArcGIS Pro also supports multiple
layouts, a feature unavailable in ArcMap. Now, users can create multiple map
layouts from the same source data and save each of them in the same project file
rather than using a Map Series or multiple MXD files.
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Figure 3. The layout view is easy to access from the Insert tab in ArcGIS
Pro.

Workflow

Figure 4. The Project Pane is
accessible via the vertical tab on the
right side of the application.
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In ArcGIS Pro, work is saved in a Project File (.aprx) rather than a Map Document
(.mxd). When starting a new project, the user is prompted to name and save the
Project File from the onset. During this process, ArcGIS Pro creates a new folder for
the Project File, default geodatabase, and all other associated files to reside in. In
other words, the user is prohibited from working in an unsaved session. This feature
should help users that tend toward disorganization –a common problem for new
users or students. I consider this a sort of built in best practice. On the other hand,
as a librarian who provides desktop and data support to students, I find the process
of saving a new project file on each occasion a bit cumbersome. For example, an
ordinary process for me is to help a student with a quick procedure like joining a
table to a shapefile on my personal computer or a shared machine then simply pass
off the exported data to the student on a flash drive. For these types of quick data
manipulation services, I have found myself sticking with ArcMap so I can work in a
sort of “burner” map document –saving a project is just not necessary. That said,
most users are not in my position and saving early and often is a good thing.

A major shift from current and past versions of the ArcGIS desktop applications to
ArcGIS Pro is the absence of associated applications such as ArcCatalog, ArcGlobe,
and ArcScene. Instead, all of these tools are rolled up together in Pro –kind of.
ArcGIS Pro’s nearest equivalent of Catalog is the Project View and Project Pane. Like
the Catalog Tab and Pane combination available in ArcMap 10, users browse
through their files and data in the Project Pane in Pro, which is accessible via the
Project Tab on the right side of the application (Figure 4). For a less cramped view
of a project’s data files, users can add a Project View by accessing the View tab
from the ribbon, then selecting Project View under Project (Figure 5). The Project
View places a new tab on the main canvas area much like the Map and Layout tabs.
If, like me, you often work with ArcMap and ArcCatalog open in tandem on dual
monitors, you can drag and drop the Project View tab to a standalone window. The
Project View is also the location for viewing metadata. ArcGlobe and ArcScene
functionality is accessible by adding a new scene under the Insert Tab. New Scenes
are Global by default, but users can convert a Scene to local view to create 3D
visualizations of buildings or terrain.
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Figure 5. Project View is as close as it gets to ArcCatalog.

Under the Hood
In terms of performance, ArcGIS Pro has an advantage over ArcMap 10. The main
performance difference between ArcMap 10 and ArcGIS Pro is that the former is a
32-bit program while the latter is a 64-bit program. A 32-bit program like ArcMap 10
can typically only access a maximum of 4 gigabytes of a computer’s RAM. The
ArcGIS 10 suite of programs was designed to run on a 32-bit operating system.
These days, however, most GIS or Map Librarians are probably working on
computers equipped with a 64-bit operating system and double or quadruple the
amount of RAM. My own work machine runs 64-bit Windows 7 with 16 gigabytes of
RAM. ArcMap can still operate on a 64-bit computer, but it can only access a
maximum of 4 gigabytes of RAM. In simple terms, when I run ArcMap on my
computer it can only use a quarter of the machine’s RAM –limiting it’s processing
speed. ArcGIS Pro, on the other hand, can take full advantage of the extra memory.
The speed boost is noticeable when working with a large dataset. If you happen to
have both ArcGIS 10 and ArcGIS Pro installed on your computer, you can see the
difference for yourself by loading one of Esri’s basemaps. The draw time for Pro is
much faster, and navigating the basemap has considerably less lag-time.

Drawbacks to ArcGIS Pro
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Figure 6. After signing out then working in
ArcGIS Pro for a while, I received this dismal
message.

License provisioning of ArcGIS Pro may cause some problems for librarians and
administrators. Following my presentation at the WAML meeting, Susan Powell of
UC Berkeley brought up the issue that users are prompted to log into their campus
ArcGIS Online account upon launching the application. The default license provision
for ArcGIS Pro is a Named User license, or in other words, that person’s campus
ArcGIS Online account. The license is tied to a user’s ArcGIS Online account with
your organization. If an organization administrator has authorized ArcGIS Pro use for
that user’s account, then signing in will allow that person to run the application
(Esri, 2016c). If the user’s account has not been configured or she does not have an
account with your campus ArcGIS Online organization, ArcGIS Pro will only run for
60 minutes (Figure 6).  Following this scenario, every student on campus who wants
to use ArcGIS Pro needs an account. However, Esri also offers two other licensing
options: single and concurrent use. Single use licenses are unique licenses for
individual machines, while concurrent use licenses allow the user to “check-out” a
license for a particular session (Esri, 2016d, 2016e). These options, combined with
some planning, may solve the problem of running ArcGIS Pro on laboratory
machines without an ArcGIS Online account.

ArcGIS Pro also lacks the full functionality of ArcMap. There are several toolboxes
that are not yet available, including coverage tools, parcel fabric tools and others
(Esri, 2016f). There is also a long list of tools from other toolboxes that have not
been added to Pro. Many cartography tools are missing and nearly 50 data
management tools have not made it into Pro. As a librarian, I have not yet found
myself in a situation where the absence of a tool has impeded my work. With that
said, I could imagine some of these missing tools creating a problem for researchers
at my institution that use GIS heavily. I have also encountered a few software bugs.
Recently I was attempting to overwrite a web layer from ArcGIS Pro but the analyze
and publish buttons were mysteriously grayed out. After searching and posting on
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the Esri Geonet Forum, I came to the realization that a software bug was the culprit.
Release notes for version 1.3 provide a list of known issues that Esri developers are
working to resolve. It is safe to consider ArcGIS Pro a work in progress, albeit a
highly functioning one.

Conclusion
Overall, I have enjoyed learning my way around ArcGIS Pro. My general impression
is that the updated interface is a real improvement. For seasoned GIS users,
relearning how to accomplish the same tasks they have carried out for years in
ArcMap will probably cause some consternation. For students or new users,
however, the usability updates will likely reduce the barrier of entry to GIS –and who
can argue with that? Each iteration seems to result in more features and fewer
bugs, and I look forward to the application gaining the functionality of ArcMap. I
plan to begin offering introductory workshops for students and faculty on my
campus beginning in the Spring 2017 semester. My library is also purchasing new
computers specifically for workshop use which will have ArcGIS Pro installed. I will
be working in the coming months to ensure the licensing for Pro on these machines
is configured in a way that does not restrict access. If you are curious about how my
work bringing ArcGIS Pro to my campus goes, then check back with me in a few
months!
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